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Chapter 18
Grouping and Advanced 

Editing of Sketched 
Objects

   Chapter OBJECTIVES
In this chapter, you will learn:
• To group sketched objects.
• To select and cycle through defined groups.
• To change properties and location of sketched objects.
• To perform editing operations on polylines.
• To explode compound objects and undo previous commands.
• To rename the named objects and remove unused named objects.



18-2 AutoCAD LT 2013 for  Des igners

GROUPING SKETCHED OBJECTS USING THE OBJECT 
GROUPING DIALOG BOX
 Ribbon:   Home > Group > Group Manager	 	 Command:  CLASSICGROUP 

To invoke the Object Grouping dialog box, you need to choose the Group Manager button from 
the Group panel in the Home tab. You can use the Object Grouping dialog box (Figure 18-1) 
to group AutoCAD LT objects and assign a name to the group. Once you have created groups, 
you can select the objects by the group name. The individual characteristics of an object are 
not affected by forming groups. Groups enable you to select all the objects in a group together 
for editing. It makes the object selection process easier and faster. Objects can be members of 
several groups. Also, a group can contain several smaller group. This may be referred to as 
nested groups.

Figure 18-1  The Object Grouping dialog box

Although an object belongs to a group, you can still select an object as if it does not belong to 
any group. Groups can be selected by entering the group name or by selecting an object that 
belongs to the group. You can also highlight the objects in a group or sequentially highlight 
the groups to which an object belongs. The options in the Object Grouping dialog box are 
discussed next.

Group Name List Box
The Group Name list box in the Object Grouping dialog box displays the names of the existing 
groups. The list box also displays whether a group is selectable or not, under the Selectable 
column. A selectable group is the one in which all members of the group are selected on selecting 
a single member. However, the members that are in frozen or locked layers are not selected. 
You can also make a group non-selectable; this allows you to select the objects in the group 
individually.

Group Identification Area
The options under the Group Identification area are as follows:

Group Name
The Group Name edit box displays the name of the selected group. You can also use the Group 
Name edit box to enter the name of a new group. You can enter any name, but it is recommended 
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that you use a name that reflects the type of objects in the group. For example, the group name 
WALLS can include all lines that form walls. Group names can be up to thirty-one characters 
long and can include letters, numbers, and special characters ($, _, and -). Group names cannot 
have spaces.

Description
The Description edit box displays the description of the selected group. It can be used to 
enter the description of a group. The description text can be up to sixty-four characters long, 
including spaces.

Find Name
The Find Name button is used to find the group name or names 
associated with an object. When you select this button, the dialog 
box temporarily disappears from the screen and AutoCAD LT 
prompts you to select an object of the group. Once you select 
the object, the Group Member List dialog box (Figure 18-2) will 
be displayed, showing the group name(s) to which the selected 
object belongs.

Highlight
The Highlight button is used to highlight the objects in the selected 
group name. This button is available only when you select a group from 
the Group Name list box. When you choose the Highlight button, 
the objects that are members of the selected group are highlighted 
in the drawing and the Object Grouping message box (Figure 18-3) 
is displayed. Choose the Continue button or press ENTER to return 
to the Object Grouping dialog box.

Include Unnamed
The Include Unnamed check box is used to display the names of the unnamed groups in 
the Object Grouping dialog box. The unnamed groups are created when you select the 
Unnamed check box in the Create Group area or when you copy the objects that belong to a 
group. AutoCAD LT automatically groups and assigns a name to the copied objects. The format 
of the name is An (for example, *A1, *A2, *A3). If you select the Include Unnamed check box, 
the unnamed group names (*A1, *A2, *A3, ...) will also be displayed in the Group Name list 
box of the dialog box. The unnamed groups can also be created by not assigning a name to the 
group (see Unnamed in the next section, “Create Group Area”).

Create Group Area
The options under this area are discussed next.
	
New
The New button is used to create a new group. To create a group, enter the name of the group in 
the Group Name edit box and then choose the New button; the Object Grouping dialog box will 
be temporarily closed and you will be prompted to select the objects to be included in the group. 
After selecting the objects, right-click; the dialog box will be displayed again and a new group 
will be created from the selected objects. The new group name is now displayed in the Group 
Name list box of the dialog box. The group names in the Group Name list box are listed 
alphabetically.

Figure 18-2  The Group Member 
List dialog box

Figure 18-3  The Object 
Grouping message box 
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Selectable
The Selectable check box allows you to define a group as selectable. A selectable group has 
a property that if you select any one object in the group, the entire group will be selected. If 
you clear this check box while defining a group, the new group created will not be selectable. 
Therefore, you need to select all members of the group individually as the entire group will not 
be selected upon selecting the individual entities of the group. 

Even if a group is defined as selectable, and the PICKSTYLE system variable is set to 0, you 
will not be able to select the entire group by selecting one of its members. You will be able to 
individually select members of the group. You can also turn the group selectability on or off by 
selecting or clearing the Object grouping check box in the Selection modes area of the Selection 
tab of the Options dialog box or by using the SHIFT+CTRL+A toggle keys.

Unnamed
When you create a group, you can assign it a name or leave it unnamed. If you select the Unnamed 
check box, AutoCAD LT will automatically assign a group name to the selected objects and these 
unnamed groups will be listed in the Group Name list box. To view the name of the unnamed 
group, the Include Unnamed check box should be selected. The format used for assigning a name 
is An (*A1, *A2, *A3 ...), where n is a number which increments by 1 with each newly added 
unnamed group.

Change Group Area
All the options under this area, other than the Re-order button, will be available only when 
you highlight a group name by selecting it in the Group Name list box of the dialog box. The 
options in this area are used to modify the properties of the existing group. These options are 
as follows.

Remove
The Remove button is used to remove objects from the selected group. Once you select the 
group name from the Group Name list box and then choose the Remove button; the dialog 
box will be temporarily closed and AutoCAD LT will display the following prompts at the 
Command prompt.

Select objects to remove from group...
Remove objects: (Select the objects that you want to remove from the selected group.)

Also, all objects belonging to the selected group will be highlighted. As you select the objects to 
be removed  from the group, they no longer appear highlighted. Note that even if you remove 
all objects from the group, the group name will still exist, unless you use the Explode option 
to remove the group definition (discussed later in this section). If you remove objects and then 
add them later in the same drawing session, the objects retain their order in the group. 

Add
The Add button is used to add objects to the selected group. When you select this option, 
AutoCAD LT will prompt you to select the objects you want to add to the selected group. The 
prompt sequence in this case will be similar to that of the Remove option. Similar to removing 
an object, all objects belonging to the selected group are highlighted and as soon as you select 
an object to be added to the group, it also gets highlighted.

Rename
The Rename button is used to rename the selected group. To rename a group, first select the 
group name from the Group Name list box, enter the new name in the Group Name edit box, 
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and then choose the Rename button. AutoCAD LT will rename the specified group. You can 
use this option to rename unnamed groups that were discussed earlier.

Re-Order
The Re-Order button is used to change the order of the objects in the selected group. The 
objects are numbered in the order in which you select them when selecting objects for the group. 
Sometimes, when creating a tool path, you may want to change the order of these objects to get 
a continuous tool motion. You can do this using the Re-Order button. This option is also useful 
in some batch operations where one object needs to be on top of another object for display 
reasons. When you choose the Re-Order button, AutoCAD LT displays the Order Group dialog 
box (Figure 18-4) where you can change the order of the group members. The following example 
explains the use of the Re-Order button using the Order Group dialog box.

Figure 18-4  The Order Group dialog box

Description
The Description button is used to change the description of the selected group. To change the 
description of a group, first select the group name from the Group Name list box, enter the new 
description in the Description text box, and then choose the Description button. AutoCAD LT 
will update the description of the specified group. 

Explode
The Explode option is used to delete group definition of the selected group. The objects that 
were in the group become regular objects without a group reference. If you had made copies of 
the group that was exploded in a drawing, they shall remain as unnamed groups in the drawing. 
You can select the Include Unnamed check box in the Group Identification area of the Object 
Grouping dialog box to view the names of the unnamed groups in the Group Name list box. 
You can then select them in the list box and explode them or rename them as required.

Selectable
The Selectable button is used to change the selectable status of the selected group. To change 
the selectable status of the group, first select the group name from the Group Name list box, 
and then choose the Selectable button. This button acts like a toggle key between the options 
of selectable and non-selectable. If the selectable status for a group is displayed as  “Yes”, you 
can choose the Selectable button to change it to “No”. Selectable implies that the entire group 
gets selected when one object in the group is selected. If the selectable status is “No”, you cannot 
select the entire group by selecting one object in the group.
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Example 1 						         Reorder Group
In this example, you will draw a rectangle representing a toolpath. The rectangle should comprise 
of four individual lines. Group all lines by selecting them in the order shown in Figure 18-5(a). 
Then, highlight the order, and reorder the grouping, as shown in Figure 18-5(b).

Figure 18-5  Changing the order of group 
objects

1. 	 Draw four lines that are connected at the end points to form a rectangle. 

2	 Type CLASSICGROUP at the Command prompt and press ENTER; the Object Grouping 
dialog box is displayed.

3.	 Type G1 in the Group Name edit box and choose the New button;  the Object Grouping 
dialog box will disappear and you will be prompted to select the objects for grouping. 

4.	 Select the lines in the order specified in Figure 18-5(a) and right-click; the Object Grouping 
dialog box is displayed again.

5.	 Make the group (G1) current by selecting it in the Group Name list box and choose the 
Re-Order button in the dialog box; the Order Group dialog box is displayed. 

6.	 Select the group G1 in the Group Name list box, if not already selected, and choose the 
Highlight button; the Object Grouping dialog box (Figure 18-6) is displayed. You can use 
the Next and Previous buttons to highlight the grouped objects in the order of selection. 

Figure 18-6  The Object Grouping dialog box
	 You will notice that the order of selection is not proper. As these lines represent a tool path, 

you need to reorder the objects as they are shown in Figure 18-5(b).

7.	 To get a clockwise tool path, you must switch object numbers 1 and 2. You can do so by 
entering the necessary information in the Order Group dialog box. Enter 1 in the Remove 
from position {0-3} edit box and 2 in the Enter new position number for the object 
{0-3} edit box. Enter 1 in the Number of objects (1-4) edit box because there is only one 
object to be replaced. 
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8.	 After entering the information, choose the Re-Order button to define the new order of the 
objects. You can confirm the change by choosing the Highlight button again and cycling 
through the objects.

GROUPING SKETCHED OBJECTS USING THE 
group button
  Ribbon:   Home > Group > Group		  		  Command:  GROUP	

In AutoCAD LT, you can group objects by using the Group button from the Group panel of 
the Home tab. Invoke the command by entering GROUP in the command box. The prompt 
sequence to create a group is given next:

Command: GROUP
Select objects or [Name/Description]: N
Enter a group name or [?]: Enter the group name 
Select objects or [Name/Description]: Select the objects to be grouped.
Select objects or [Name/Description]: 
Group “group name” has been created.

You can also group the objects by using the shortcut menu. Select the objects to be grouped, 
and right-click in the drawing area; a shortcut menu will be displayed. Choose Group>Group 
from the shortcut menu; the selected objects will be grouped as Unnamed group.

Later on, you can ungroup them using the Ungroup option from the same shortcut menu.

Selecting Groups
You can select a group by name by entering G at the Select objects prompt. For example, if you 
have to move a particular group, choose the Move tool from the Modify panel in the Home tab  
and then enter the following prompt sequence:

Select objects: G
Enter group name: Enter the group name 
n found
Select objects: 

Instead of entering G at the Select Objects: prompt, if you select any member of a selectable 
group, all the group members get selected. Make sure that the PICKSTYLE system variable is 
set to 1 or 3. Also, the group selection can be turned on or off by pressing SHIFT+CTRL+A. If 
the group selection is off and you want to erase a group from a drawing, choose the Erase tool 
from the Modify panel. The prompt sequence for erasing the group is given next.

Select objects: Press SHIFT+CTRL+A 			 
<Groups on> Select an object that belongs to a group. (If the group has been defined as selectable, 
all objects belonging to that group will be selected.)

If the group has not been defined as selectable, you cannot select all objects in the group, even 
if you turn the group selection on by pressing the SHIFT+CTRL+A keys. This setting can also 
be changed in the Selection tab of the Options dialog box. You can select or clear the Object 
grouping check box in the Selection modes area of the dialog box to turn group selectability 
on or off. 
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Tip
The keyboard shortcut SHIFT+CTRL+A is used as a toggle key to turn the group selection 
on or off.

Changing Properties of an Object
AutoCAD LT provides you different options for changing the properties of an object. These 
options are discussed next.

Using the Properties Palette
  Ribbon: View > Palettes > Properties		              Toolbar:  Standard > Properties 	 
  Quick Access Toolbar: Properties (Customize to Add)	 Command:  PROPERTIES or PR	

The categories displayed in the Properties palette depend on the type of object selected. 
The General category displays the general properties of objects, such as color, layer, 
linetype, linetype scale, plot style, lineweight, hyperlink, and thickness. The procedure 

to change the general properties of objects using the Properties palette has already been discussed 
earlier in Chapter 4, Working with Drawing Aids. In this chapter, the Geometry category containing 
properties that control the geometry of an object will be discussed. Depending on the type of 
object selected, the Geometry category will contain a set of different properties. If you have 
selected many types of objects in a drawing, the edit box at the top of the Properties palette 
display All, General, and Plot Style categories. If you select a type of object from the drop-down 
list, the corresponding categories of the object properties will be displayed in the palette. You 
can also invoke the Properties palette from the shortcut menu displayed on selecting the 
object.

Selecting a Line
If you have selected a line in the drawing, the Properties palette 
appears similar to what is shown in Figure 18-7, where you 
can change the properties of the selected object. 

Figure 18-7  The Properties 
palette 

Start X/Start Y/Start Z. The Start X/Start Y/Start Z fields in 
the Geometry category display the start point coordinates of 
the selected line. You can enter new values in these fields or 
use the Pick Point button that appears in the field you click 
in. When you choose the Pick Point button, a rubber-band 
line gets attached to the cursor on its start point and the 
endpoint of the line is fixed. You can now move the cursor 
and specify a new start point for the line.

End X/End Y/End Z. Similar to the start point, you can also 
modify the location of the endpoint of a line by entering new 
coordinate values in the End X, End Y, End Z fields. You can 
also choose the Pick Point button in the respective fields and 
select a new location for the endpoint of the selected line. 
This Pick Point button appears in the fields when you click 
on them.

Note
The Delta X, Delta Y, Delta Z, Length, and Angle fields are not available for change but the 
values in these fields get updated as the start and endpoints of the line are changed.
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Selecting a Circle
When you select a circle, the Geometry category displays the

Figure 18-8  The Geometry 
category of the Properties palette 
for a circle

 
categories as shown in Figure 18-8. You can modify the values 
in these fields. The effects of modifying the values are discussed 
next.

Center X/Center Y/Center Z. Here, under the Center X/
Center Y/Center Z fields of the Geometry category, you can 
specify a new location of the center point of the circle by 
entering new coordinate values in the Center X, Center Y, 
and Center Z fields. When you click in any of these fields; the 
Pick Point button is displayed. You can choose this button to 
locate a new location of the center point of the circle. The 
circle will be drawn at the new location with the same radius 
as specified before. It is as if the circle has moved from the old 
location to a new one.

Radius/Diameter. You can enter a new value for the radius or diameter of the circle in the 
Radius or Diameter fields respectively. The circle’s radius or diameter is modified as per the 
new values you have entered. As you modify the values of the radius or the diameter, the values 
in the Circumference and Area fields get modified accordingly.

Note
You can also enter new values of the circumference or area in the Circumference and Area 
fields, respectively, if you want to create a circle with a given value of circumference or area. 
You will notice that the radius and diameter values are modified accordingly. The Normal X, 
Normal Y, and Normal Z fields are not available for modifications.

Selecting the Multiline Text
If you select multiline text written in a drawing and invoke 
the Properties palette, apart from the General category, three 
more categories of properties are displayed: Text, Visualization 
and Geometry. The properties in the Test and Geometry 
categories (Figure 18-9) and how they can be modified are 
discussed next.

Figure 18-9  The Geometry and 
Text categories of the Properties 
palette for text

Contents. The current contents of the text are displayed in 
the Contents field under the Text category of the Properties 
palette. To modify the contents, click in the field and the [...] 
button is displayed at the right-corner of the field. You can 
then choose this button to display the Text Editor where you 
can make the necessary modifications using the options in the 
dialog box. Once you have made the changes, choose the Close 
Text Editor button from the Text Editor contextual tab to 
exit the text editing and return to the Properties palette. The 
changes you made are reflected in the value of the Contents 
field of the Properties palette and in the drawing.

Style. When you click in the Style field in the Properties palette, 
a drop-down list of the defined text styles is displayed. By 
default, only the Standard style is displayed. If you had 
defined more text styles in the drawing, they can be selected 
from the drop-down list and applied to the current text in the 
drawing.
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Annotative. You can convert the non-annotative text to annotative and vice-versa by selecting 
the Yes and No options respectively from the Annotative drop-down list.    

Justify. All the text justification options are available in the Justify drop-down list. This 
drop-down list is available when you click in the Justify field. By default, the Top left justification 
is applied to the text. You can select a text justification from the drop-down list to be applied 
to the selected text in the drawing.

Direction. This drop-down list displays the possible directions for the text. This option is 
generally available for the multiline text objects.

Text height. You can enter a new value for the height of the selected text in the drawing. The 
default text height is 0.2. But, you can make the text smaller or larger in the drawing by simply 
entering a new value in the Text height field of the Properties palette.

Rotation. This field displays the current angle of the selected text and is 0-degree by default. 
You can change the angle of rotation of the text by entering an angle by which you want to rotate 
the selected text in the Rotation field and then pressing ENTER. The effect is immediately 
visible in the drawing.

Line space factor. The effect of changing the value of this field is more evident when you have 
selected a paragraph or multiline text. This value controls the spacing between the lines in a 
paragraph or multiline text. A scale factor of 1 is the default value. You can increase or decrease 
the spacing between the lines of the selected paragraph text by entering a new scale factor of 
your choice and pressing ENTER. The result is immediately visible in the drawing.

Line space distance. This field is used to modify the distance between the spacing of each 
line of the multiline text. Click in this field and enter the new value in it.

Line space style. This field when selected displays two line spacing options in the corresponding 
drop-down list. They are Exactly and At least. At least is the default option.

Background mask. This field specifies whether or not any background mask is assigned to 
the multiline text.

Columns. Columns are of three types, None, Static, or Dynamic. To edit the column settings, 
choose the [...] button; the Column Settings dialog box will be displayed. You can change the 
column settings through this dialog box.  

Defined width/Defined height. These fields display the defined width/height of the text window 
in the In-Place Text Editor. These fields will be available, if you select the None option from 
the Columns field. To change the values of these fields, click in the field and enter the new 
value in it.

Position X/Position Y/Position Z. You can change the location of the insertion point of the 
selected text by entering new X/Y/Z coordinates for the text in these fields. You can also use the 
Pick Points button that is displayed in these fields when you click in them. When you choose 
the Pick Points button, a rubber-band line is attached between the cursor and the selected text 
and you can move the cursor and specify a new location for the text on the screen. The values 
of the three fields get updated automatically.

Selecting the Annotative Block Reference
When you select a block in the drawing and invoke the Properties palette, apart from the 
General category, three more categories containing the properties of the block are available. 
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They are Geometry, Visualization, and Misc. The properties under these categories are 
discussed next.

Position X/Position Y/Position Z. In the Position X/Position Y/Position Z fields of the Geometry 
category, you can enter new X, Y, and Z coordinates respectively for the selected block. The 
block reference shall move to the new location as you specify the coordinates. You can also click 
in any one of the fields to display the Pick Points button and choose it to specify a new location 
for the block on the screen. 

Scale X/Scale Y/Scale Z. You can specify new X, Y, and Z scale factors for the selected block in 
the Scale X, Scale Y, and Scale Z fields, respectively. The current scale factors for the block are 
displayed in the Scale X, Scale Y, and Scale Z fields and as you change them, the modifications 
are reflected in the drawing.

Name. This field under the Misc category displays the name of the selected block reference 
and is not available for modifications.

Rotation. This field specifies the current rotation angle of the selected block. You can specify 
a new angle of rotation for the selected block in this field. After specifying an angle, when you 
press ENTER, the selected block in the drawing is rotated through the specified angle.

Annotative. This field specifies whether the block is annotative or non-annotative. This 
information is read-only.

Annotative scale. This field displays the current annotation scale of the drawing. You can add 
more annotation scales to the drawing in the Annotation Object Scale dialog box that will be 
displayed when you choose the [...] button from the Annotative scale field.

Match orientation to layout. This field displays whether or not the orientation of the text used 
in the block is forced to align with the orientation of the floating viewports. This information 
is read-only. 

Block Unit. This field specifies the unit of the block.

Unit factor. This field specifies the conversion factor between the block unit and the 
drawing unit.

Selecting the Annotative Attribute
When you select an attribute before converting it into a block, apart from the General category, 
the other four categories under which the properties of an attribute are displayed are Text, 
General, Visualization, and Misc. How to use the Properties palette to edit an attribute has 
already been discussed in Chapter 15, Defining Block Attributes.
 
Tag. You can modify the text of the tag by entering a new value in the Tag field under the Text 
category. After you have modified the tag text and pressed ENTER, the old attribute text in the 
drawing is replaced by the new text.

Annotative. This field specifies whether the attribute is annotative or non-annotative. Select 
the appropriate option from the Annotative drop-down list to change the annotative property 
of the attributes. 

Annotative scale. This field displays the current annotation scale of the drawing. You can add 
more annotation scales to the drawing in the Annotation Object Scale dialog box that will be 
displayed when you choose the [...] button from the Annotative scale field. 
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Prompt. You can also change the text of the prompt and enter a new prompt value in the 
Prompt field.

Value. This field displays the default value of the selected attribute. You can change this default 
value by entering a new value in the Value field.

Style. When you click in this field, the Style drop-down list is available. You can select a style for 
the attribute text from this drop-down list. Only the text styles that already have been defined 
are available in this drop-down list and can be selected.

Justify. You can select an attribute text justification from the Justify drop-down list. 

Paper text height. This field displays the height of the annotative text that is to be maintained on 
the paper. 

Model text height. This field displays the height of the text that is to be displayed in the 
model space. The Model text height value depends on the Paper text height value and the 
Annotative scale.

Height. You can change the height of the selected non-annotative attribute text by entering a 
new value in this field.

Rotation. You can rotate the selected attribute text by specifying an angle in the 
Rotation field.

Width factor. You can modify the width factor of the attribute text by entering a new value in 
the Width factor field of the Properties palette. 

Obliquing. The attribute text can also be made slanting by entering an angle value in the 
Obliquing field of the Properties palette.

Direction. This field displays the flow direction of the attribute text. You can select the desired 
flow direction from the Horizontal, Vertical, or By style option (defined in the Textstyle) in 
the Direction drop-down list.

Boundary Width. This field displays the width of the text window in the In-Place Text Editor. 
The value displayed here is the relative value; specifying a value less than 1 will decrease the 
boundary width and a value more than 1 will increase the boundary width. The value in the 
Boundary Width will be available only if the Multiple lines check box is selected in the Mode 
area of the Attribute Definition dialog box. You can also select the Yes option from the Multiple 
lines drop-down list in the Misc area of the Properties Palette.

Text alignment X/Text alignment Y/Text alignment Z. The Text alignment X/Text 
alignment Y/Text alignment Z fields of the Text category display the X, Y, and Z coordinates 
of the alignment point of the selected attribute. Note that these fields will be available only if 
you modify the properties such as the text alignment of the attributes, while defining them. If 
these fields are available and you click on them, the Pick Point button appears in the field. You 
can use this button to specify the new location of the attribute.

Note
If you modify the text alignment of the first attribute and define the remaining attributes below 
the this attribute, the remaining attributes will also have the Text Alignment fields active.
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Misc. As discussed earlier, under the Misc category, you can redefine the attribute modes that 
have been defined at the time of the attribute definition. You can also make the attribute text 
appear upside-down or backwards by selecting Yes from the Upside down drop-down list and 
the Backward drop-down list, respectively.

Note
Choose the QuickCalc button from the respective fields to open the Quick Calculator. Using 
the Quick Calculator, you can enter the numerical values as mathematical equations. These 
equations may include scientific calculations. You can also perform units conversion using the 
Quick Calculator. 

Exercise 1 							        Properties
Draw a hexagon on layer OBJ in red color. Let the linetype be hidden. Now, use the 
Properties palette to change the layer of the hexagon to some other existing layer, the color 
to yellow, and the linetype to continuous. Also, in the Properties palette, under the Geometry 
category, specify a vertex in the Vertex field or select one using the arrow (Next or Previous) 
buttons and then relocate it. The values of the Vertex X and Vertex Y fields change as the 
coordinate values of the vertices change. Also, notice the change in the value in the Area field. 
You can also assign a start and end lineweight to each of the hexagon segments between the 
specified vertices. Use the LIST command to verify that the changes have taken place.

Exploding Compound Objects
  Ribbon:   Home > Modify > Explode	 Toolbar:  Modify > Explode	  
  Menu Bar: Modify > Explode		  Command:  EXPLODE		

The Explode tool is used to split compound objects such as blocks, polylines, regions, 
polyface meshes, polygon meshes, multilines, or dimensions into the basic objects that 
make them up (Figure 18-10). For example, if you explode a polyline, the result will be 

ordinary lines or arcs (tangent specification and width are not considered). When a polygon 
mesh is exploded, the result is faces. Polyface meshes are turned into faces, points, and lines. 
On exploding, 2D polylines lose their width and tangent specifications and polylines explode 
into lines. When a body is exploded, it changes into single-surface bodies, curves, or regions. 
When a leader is exploded, the components are lines, splines, solids, block inserts, text or 
multiline text, tolerance objects, and so on. Multiline text explodes into a single line text. This 
tool is especially useful when you have inserted an entire drawing and you need to alter a small 
detail. After you invoke the Explode tool, you are prompted to select the objects you want to 
explode. After selecting the objects, press ENTER or right-click to explode the selected objects 
and then end the command.

When a block or dimension is exploded, there is no visible change in the drawing. The drawing 
remains the same except that the color and linetype may have changed because of floating 
layers, colors, or linetypes. The exploded block is turned into a group of objects that can be 
modified separately. To check whether the explosion of the block has taken place, select any 
object that was a part of the block. If the block has been exploded, only that particular object 
will be highlighted. With the EXPLODE command, only one nesting level is exploded at a time. 
Hence, if there is a nested block or a polyline in a block and you explode it, the inner block or 
the polyline will not be exploded. Attribute values are deleted when a block is exploded, and 
the attribute definitions are redisplayed. 
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Figure 18-10  Use of the EXPLODE command

Note
Remember that the blocks inserted using the MINSERT command and x-refs cannot be exploded. 
This command has been discussed in relation to the blocks in Chapter 14.

Tip
If you want to insert a block in the form of its separate components while using the 
Insert command, select the Explode check box in the Insert dialog box. Also, if you are 
using the -INSERT command, type * in front of the block name at the Enter block name or 
[?]: prompt, the block will be inserted in the drawing as separate component object, and not as 
an entire block.

Editing Polylines 
A polyline can assume various characteristics such as width, linetype, joined polyline, and closed 
polyline. You can edit polylines, polygons, or rectangles to attain the desired characteristics using 
the Edit Polyline tool. In this section, we will be discussing how to edit simple 2D polylines. 
The following are the editing operations that can be performed on an existing polyline using 
the Edit Polyline tool. These operations are discussed in detail later in this chapter.

1.	 A polyline of varying widths can be converted to a polyline of uniform width.

2.	 An open polyline can be closed and a closed one can be opened.

3.	 You can remove bends and curved segments between two vertices to make a straight 
polyline.

4.	 A polyline can be split up into two and individual polylines or polyarcs connected to one 
another can be joined into a single polyline.

5.	 After invoking the Edit Polyline tool, if you select an entity that is not a polyline, you are 
prompted to specify whether you want the entity to be converted into a polyline. You can 
avoid this prompt by setting the value of the PEDITACCEPT variable to 1.

6.	 Multiple polylines can be edited.

7.	 The appearance of a polyline can be changed by moving and adding vertices.

8.	 Curves of arcs and B-spline curves can be fitted to all vertices in a polyline, with the 
specification of the tangent of each vertex being optional.
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9.	 The linetype generation at the vertices of a polyline can be controlled.

10.	 Multiple polylines can be joined together to form a single polyline.

Editing Single Polyline
  Ribbon: Home > Modify > Edit Polyline	       Toolbar:  Modify II > Edit Polyline	  
  Menu Bar:  Modify > Object > Polyline	        Command: PEDIT			 

Apart from the methods displayed in the command box, you can also invoke the Edit 
Polyline tool by choosing Polyline Edit from the shortcut menu that is displayed when 
you select a polyline and right-click. You can use the Edit Polyline tool to edit any type 

of polyline. When you invoke this tool, the following prompt sequence is displayed:

Select polyline or [Multiple]:

If the selected entity is not a polyline, the following message will be displayed at the 
Command prompt.

Object selected is not a polyline.
Do you want to turn it into one? <Y>:

If you want to turn the object into a polyline, respond by entering Y and pressing ENTER or 
by simply pressing ENTER. To let the object be as it is, enter N. AutoCAD LT will then prompt 
you to select another polyline or object to edit. As mentioned earlier, you can avoid this prompt 
by setting the value of the PEDITACCEPT variable to 1. The subsequent prompts and editing 
options depend on the type of polyline that has been selected. AutoCAD LT provides you the 
option of either selecting a single polyline or multiple polylines. In this case, a single 2D polyline 
is selected, the next prompt displayed is given next.

Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/Undo]: 
Enter an option or press ENTER to end command.

Note
Depending on the type of polyline selected, the PEDIT command options change. In this chapter, 
the 2D polyline options have been discussed. 

The options available in the Single polyline selection method are discussed next.

Close (C) Option
This option is used to close an open polyline. Close creates the segment that connects the last 
segment of the polyline to the first. You will get this option only if the polyline is not closed. 
Figure 18-11 illustrates this option.

Open (O) Option 
If you close an open polyline, the Close option is replaced by the Open option. Enter O for 
open, the closing segment is removed, see Figure 18-11.

Join (J) Option
This option appends lines, polylines, or arcs whose endpoints meet a selected polyline at any of 
its endpoints and adds (joins) them to it (Figure 18-12). This option can be used only if a polyline 
is open. After this option has been selected, AutoCAD LT prompts you to select objects. Once 
you have chosen the objects to be joined to the original polyline, AutoCAD LT examines them 
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to determine whether any of them has an endpoint in common with the current polyline, and 
joins such an object with the original polyline. The search is then repeated using new endpoints. 
They will not join if the endpoint of the object does not exactly meet the polyline. The line 
touching a polyline at its endpoint to form a T will not be joined. If two lines meet a polyline in 
a Y shape, only one of them will be selected, and this selection depends upon the sequence of 
selecting the lines. If you select the two lines, the first selected line will get joined to the polyline. 
To verify which lines have been added to the polyline, use the LIST command or select a part 
of the object. All the segments that are joined to the polyline will be highlighted.

Figure 18-12  Using the Join optionFigure 18-11  The Close and Open options

Width (W) Option
The W option allows you to define a new, unvarying width for all segments of a polyline 
(Figure 18-13). It changes the width of a polyline with a constant or a varying width. The desired 
new width can be specified either by entering the width using the keyboard or by specifying the 
width as the distance between the two specified points. Once the width has been specified, the 
polyline assumes it. Here, you will change the width of the given polyline in figure from 0.02 to 
0.05 (Figure 18-14). On invoking the Edit Polyline tool, the following prompt is displayed:

Select polyline or [Multiple]: Select a polyline.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/
Undo]: W 
Specify new width for all segments: 0.05

Figure 18-13  Making the width of a polyline 
uniform

Figure 18-14  Changing the width of all segments
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Note
Circles drawn using the CIRCLE command cannot be changed to polylines. However, for 
polycircles drawn by using the Arc option of the Polyline tool (by drawing two semicircular 
polyarcs) or by using the Donut tool, you can modify the thickness using the Width option of 
the Polyline Edit tool.

Edit vertex (E) Option
The Edit vertex option lets you select a vertex of a polyline and perform different editing 
operations on the vertex and the segments following it. A polyline segment has two vertices. 
The first one is at the start point of the polyline segment; the other one is at the endpoint of 
the segment. When you invoke this option, an X marker appears on the screen at the first vertex 
of the selected polyline. If a tangent direction has been specified for this particular vertex, 
an arrow is generated in that direction. After this option has been selected, the next prompt 
appears with a list of options for this prompt. The prompt sequence, after you invoke the Edit 
Polyline tool, is given next.

Select polyline or [Multiple]: Select the polyline to be edited.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/
Undo]: E 
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: Enter an 
editing option or press ENTER to accept default.

All the options for the Edit vertex option are discussed next.

Next and Previous Options. These options move the X marker to the next or the previous 
vertex of a polyline. The default value in the Edit vertex option is one of these two options. 
The option that is selected as default is the one you chose last. In this manner, the Next and 
Previous options help you to move the X marker to any vertex of the polyline by selecting one 
of these two options, and then pressing ENTER to reach the desired vertex. These options cycle 
back and forth between the first and last vertices, but cannot move past the first or last vertex, 
even if the polyline is closed (Figure 18-15).

Figure 18-15  The Next and Previous options
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The prompt sequence for using this option, after you invoke the Edit Polyline tool, is given 
next.

Select polyline or [Multiple]: Select the polyline to be edited.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/
Undo]: E 
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit] <N>: Enter N 
or P to move to the next or previous vertices respectively.

Break Option. With the Break option, you can remove a portion of the polyline, as shown in 
Figure 18-16 or break it at a single point. You can specify the vertices within which the polyline 
would be removed. By specifying two different vertices, all the polyline segments and vertices 
between the specified vertices are erased. If one of the selected vertices is at the endpoint of the 
polyline, the Break option will erase all the segments between the first vertex and the endpoint 
of the polyline. The exception to this is that AutoCAD LT does not erase the entire polyline, if 
you specify the first vertex at the start point (first vertex) of the polyline and the second vertex 
at the endpoint (last vertex) of the polyline. If both vertices are at the endpoint of the polyline, 
or only one vertex is specified and its location is at the endpoint of the polyline, no change is 
made to the polyline. The last two selections of vertices are treated as invalid by AutoCAD LT, 
which acknowledges this by displaying the message *Invalid*.

Figure 18-16  Use of the Break option

To use the Break option, first you need to move the marker to the first vertex where you want 
the split to start. The placement of the marker can be achieved with the help of the Next and 
Previous options. Once you have selected the first vertex to be used in the Break operation, 
invoke the Break option by entering B at the Command prompt. AutoCAD LT takes the vertex 
where the marker (X) is placed as the first point of the breakup. The next prompt asks you to 
specify the position of the next vertex for the breakup. You can enter GO at this prompt if you 
want to split the polyline at one vertex only. Otherwise, use the Next or Previous option to 
specify the position of the next vertex and then enter GO. On doing so, the polyline segments 
between the two selected vertices will be erased. The prompt sequence for using this option, 
after you have invoked the Edit Polyline tool, is given next.

Select polyline or [Multiple]: Select the polyline to be edited.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/
Undo]: E 
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: Enter N or 
P to locate the first vertex for the Break option.
Enter a vertex editing option
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[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: B 

Once you invoke the Break option, AutoCAD LT treats the vertex where the marker (X) is 
displayed as the first point for splitting the polyline. The next prompt issued is given next.

Enter an option [Next/Previous/Go/eXit] <N>: Enter G if you want to split the polyline at one 
vertex only or move the X marker using the Next or Previous option to specify the position of the next 
vertex for breakup.

After you have specified the next position of the X marker using the Next and Previous options, 
entering GO deletes the polyline segment between the two markers specified. Now, exit the 
Enter a vertex editing option prompt using the eXit option.

Insert Option. The Insert option is used to define a new vertex and add it to the polyline 
(Figure 18-17). You can invoke this option by entering I for Insert. You should invoke this option 
only after you have moved the marker (X) to the vertex after which the new vertex is to be added. 
The new vertex is inserted immediately after the vertex with the X mark. After you invoke the 
Edit Polyline tool, the prompt sequence for using the Insert option will be as follows:

Figure 18-17  Using the Insert option to define new vertex points

Select polyline or [Multiple]: Select the polyline to be edited.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/
Undo]: E 
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: Move the 
marker to the vertex after which the new vertex is to be inserted.
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: I 
Specify location for new vertex: Move the cursor and select to specify the location of the new vertex 
or enter the coordinates of the new location.

Tip
In AutoCAD LT, you can insert vertex by using the shortcut menu. To do so, select a polyline; the 
grips will be displayed. Move the cursor near one of the grips; a shortcut menu will be displayed. 
Choose the Add Vertex option and click on the drawing area to add new vertex. You can also 
stretch the selected arc or convert the line to arc or vice versa by selecting appropriate option 
from the shortcut menu.
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Move option. This option is used to move the X-marked vertex to a new position (Figure 18-18). 
Before invoking the Move option, you must move the X marker to the vertex you want to relocate 
by selecting the Next or Previous option. The prompt sequence for relocating a vertex after 
you invoke the Edit Polyline tool is given next.

Select polyline or [Multiple]: Select the polyline to be edited.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/
Undo]: E 
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: Enter N or 
P to move the X marker to the vertex you want to relocate.
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: M 
Specify new location for marked vertex: Specify the new location for the selected vertex by using 
the pick button of your pointing device or by entering its coordinate values.
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: Enter an 
option or enter X to exit.

Figure 18-18  The Move option

Regen Option. The Regen option regenerates the polyline to display the effects of edits you 
have made, without having to exit the vertex mode editing. It is used most often with the Width 
option.

Straighten Option. The Straighten option is used to straighten polyline segments or arcs 
between specified vertices (Figure 18-19). It deletes the arcs, line segments, or vertices between 
the two specified vertices and substitutes them with one polyline segment.

The prompt sequence to use this option after you invoke the Edit Polyline tool is given next.

Select polyline or [Multiple]: Select the polyline to be edited.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/
Undo]: E 
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: Move the 
marker to the desired vertex from where you want to start applying the Straighten option with the 
Next or Previous option.
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: S
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Enter an option [Next/Previous/Go/eXit] <N>: Move the marker to the next desired vertex, until 
you reach the vertex you want to straighten.
Enter an option [Next/Previous/Go/eXit] <N>: G 

The polyline segments between two marker locations are replaced by a single straight line 
segment. If you specify a single vertex, the segment following the specified vertex is straightened, 
if it is curved. 

Figure 18-19  Using the Straighten option to straighten polylines

Tangent option. The Tangent option is used to associate a tangent direction to the current 
vertex (marked by X). The tangent direction is used in the curve fitting or the Fit option of the 
Edit Polyline tool. This option is discussed in detail in the subsequent section on curve fitting. 
The prompt issued on using the Tangent option is given next.

Specify direction of vertex tangent: Specify a point or enter an angle.

You can specify the direction of the vertex tangent by entering an angle at the previous prompt 
or by selecting a point to express the direction with respect to the current vertex. You can then 
move the marker to another vertex using the Next or Previous option and change its direction 
of tangent or enter X to exit the Enter a vertex editing option prompt.

Width option. The Width option lets you change the width at the start and end points of a 
polyline segment that follows the current vertex (Figure 18-20). By default, the ending width 
is equal to the starting width and hence, you can get a polyline segment of uniform width by 
pressing ENTER at the Specify ending width for next segment <starting width> prompt. 
You can also specify different starting and ending widths to get a varying-width polyline. The 
prompt sequence is given next.

Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/Undo]: 
E 
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: Move the 
marker to the starting vertex of the segment whose width is to be altered, using the Next or Previous 
option.
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: W 
Specify starting width for next segment <current>: Enter the revised starting width.
Specify ending width for next segment <starting width>: Enter the revised ending width or 
press ENTER to accept the default option of keeping the ending width of the segment equal to the 
starting width.
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Figure 18-20  Using the Width option to change the width of a polyline

If no difference is noticed in the appearance of the polyline, you may need to use the Regen 
option. The segment with the revised widths is redrawn after invoking the Regen option or 
when you exit the vertex mode editing.

eXit Option. This option lets you exit the vertex mode editing and return to the PEDIT 
prompt.

Fit Option
The Fit or Fit curve option is used to generate a curve that passes through all the corners 
(vertices) of the polyline, using the tangent directions of the vertices (Figure 18-21). 

The curve is composed of a series of arcs passing through the corners (vertices) of the polyline. 
This option is used when you draw a polyline with sharp corners and you need to convert it into 
a series of smooth curves. An example of this is a graph. In a graph, we need to show a curve 
by joining a series of plotted points. The process involved is called curve fitting; therefore, this 
option is known as Fit. The vertices of the polyline are also known as the control points. The 
closer these control points are, the smoother is the curve. Therefore, if the Fit option does not 
give optimum results, insert more vertices into the polyline or edit the tangent directions of 
vertices and then use the Fit option on the polyline. Before using this option, you may give each 
vertex a tangent direction. 

Figure 18-21  Curves generated using the Fit option
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The curve is then constructed, according to the tangent directions you have specified. The 
following prompt sequence illustrates the Fit option after you invoke the Edit Polyline tool.

Select polyline or [Multiple]: Select the polyline to be edited.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/
Undo]: F 

If the tangent directions need to be edited, use the Edit vertex option of the Edit Polyline 
tool. Move the X marker to each of the vertices that need to be changed. Now, you can invoke 
the Tangent option, and either enter the tangent direction in degrees or select points. The 
chosen direction is expressed by an arrow placed at the vertex. The prompt sequence to use the 
Tangent option of the Edit Polyline tool is given next.

Select polyline or [Multiple]: Select the polyline to be edited.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/
Undo]: E 
Enter a vertex editing option
[Next/Previous/Break/Insert/Move/Regen/Straighten/Tangent/Width/eXit]<N>: T 
Specify direction of vertex tangent: Specify a direction in + or - degrees, or select a point in the 
desired direction. Press Enter.

Once you specify the tangent direction, use the eXit option to return to the previous prompt 
and use its Fit option.

Tip
In AutoCAD LT, after applying Fit option to a polyline, you can change the tangent direction by  
using the tool tip. To do so, select a polyline; the grips will be displayed. Move the cursor near 
one of the grips; a tooltip will be displayed. Choose the Tangent Direction option and specify 
the new direction in the drawing area.

Spline Option
The Spline option (Figure 18-22) also smoothens the corners of a straight segment polyline, 
as does the Fit option, but the curve passes through only the first and the last control points 
(vertices), except in the case of a closed polyline. The spline curve is stretched toward the other 
control points (vertices) but does not pass through them, as in the case of the Fit option. The 
greater the number of control points, the greater the force with which the curve is stretched 
toward them. The prompt sequence on invoking the Edit Polyline tool is as follows:

Select polyline or [Multiple]: Select the polyline.
Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype 
gen/Reverse/Undo]: S 

The generated curve is a B-spline curve. The frame is the original polyline without any curves 
in it. If the original polyline has arc segments, these segments are straightened when the spline’s 
frame is formed. A frame that has width produces a spline curve that tapers smoothly from the 
width of the first vertex to that of the last. Any other width specification between the first width 
specification and the last is neglected. When a spline is formed from a polyline, the frame is 
displayed as a polyline with a zero width and a continuous linetype. Also, AutoCAD LT saves 
its frame so that it may be restored to its original form. Tangent specifications on control point 
vertices do not affect spline construction. 
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Figure 18-22  Smoothening the corners using the Spline option

By default, the spline frames are not shown on the screen, but you may want them displayed for 
reference. In this case, the system variable SPLFRAME needs to be manipulated. The default 
value for this variable is zero. If you want to see the spline frame as well, set it to 1. 

Now, whenever the Spline option is used on a polyline, the frame will also be displayed. Most 
editing tools such as Move, Erase, Copy, Mirror, Rotate, and Scale work similarly for both the 
Fit curves and Spline curves. They work on both the curve and its frame, whether the frame 
is visible or not. The Extend tool changes the frame by adding a vertex at the point the last 
segment intersects with the boundary. If you use any of the previously mentioned tools and then 
use the Decurve option to decurve the spline curve and later use the Spline option again, the 
same spline curve is generated. The Break, Trim, and Explode tools delete the frame. The 
Divide, Measure, Fillet, Chamfer, Area, and Hatch tools recognize only the spline curve and 
do not consider the frame. The Stretch tool first stretches the frame and then fits the spline 
curve to it. 

When you use the Join option of the PEDIT command, the spline curve is decurved and the 
original spline information is lost. The Next and Previous options of the Edit vertex option of 
the Edit Polyline tool move the marker only to the points on the frame, whether visible or not. 
The Break option discards the spline curve. The Insert, Move, Straighten, and Width options 
refit the spline curve. Object Snaps consider the spline curve and not the frame; therefore, if 
you wish to snap to the frame control points, restore the original frame. 

There are two types of spline curves: Quadratic B-spline and Cubic B-spline

These types of curves pass through the first and the last control points, which is the characteristic 
of the spline curve. Cubic curves are very smooth. A cubic curve passes through the first and 
last control points, and the curve is closer to the other control points. Quadratic curves are not 
as smooth as the cubic ones, but they are smoother than the curves produced by the Fit curve 
option. A quadratic curve passes through the first and last control points, and the rest of the curve 
is tangent to the polyline segments between the remaining control points (Figure 18-23).
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Figure 18-23  Comparison of fit curve, quadratic B-spline, and cubic B-spline

	 Generation of different types of spline curves. If you want to edit a polyline into a B-spline 
curve, you are first required to enter a relevant value in the SPLINETYPE system variable. 
A value of 5 produces the quadratic curve, whereas a value of 6 produces a cubic curve. The 
default value is 6, which implies that when we use the Spline option of the Edit Polyline 
tool, a cubic curve is produced by default. You can change the value of the SPLINETYPE 
variable using the Command prompt.  

	 In case you are editing polygon meshes, the smoothness of the meshes is controlled by the 
SURFTYPE variable. The value of the variable can be set on the Command prompt. You 
can select the type of polygon mesh you want when you are using the Smooth Surface op-
tion of the Edit Polyline tool from the Set Spline Fit Variables dialog box.

	 SPLINESEGS. The system variable SPLINESEGS governs the number of line segments 
used to construct the spline curves, and therefore you can use this variable to control the 
smoothness of the curve. The default value for this variable is 8. With this value, a reasonably 
smooth curve that does not need much regeneration time is generated. The greater the 
value of this variable, the smoother the curve, but greater the regeneration time, the more 
space occupied by the drawing file.

	 Figure 18-24 shows cubic curves with different values for the SPLINESEGS variable.

Decurve Option 
The Decurve option straightens the curves generated after using the Fit or Spline option on 
a polyline. On using this option, the curves return to their original shape (Figure 18-25). The 
polyline segments are straightened using the Decurve option. The vertices inserted after using 
the Fit or Spline option are also removed. Information entered for the tangent reference is 
retained for use in future fit curve operations. You can also use this tool to straighten out any 
curve drawn with the help of the Arc option of the Polyline tool. Enter D at the Enter an option 
[Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Reverse/Undo] prompt to invoke 
the Decurve option of the Edit Polyline tool.
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Figure 18-25  Using the Decurve optionFigure 18-24  Using the SPLINESEGS variable

Note
If you use editing tools such as the Break or Trim on spline curves, the Decurve option cannot 
be used.

Ltype gen Option 
You can use this option to control the linetype pattern generation for linetypes other than 
Continuous with respect to the vertices of the polyline. This option has two modes: ON and 
OFF. If turned off, the break in the noncontinuous linetypes will be avoided at the vertices of the 
polyline and a continuous segment will be displayed at the vertices (Figure 18-26). If turned on, 
this option generates the linetype in a continuous pattern such that the gaps may be displayed 
at the vertices. This option is not applicable to polylines with tapered segments.

The command prompt displayed when you select a polyline and invoke the Ltype gen option 
of the Edit Polyline tool is given next.

Enter polyline linetype generation option [ON/OFF] <Off>: Enter ON or press ENTER to 
accept the default value.

Figure 18-26  Using the Ltype gen option
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The linetype generation for new polylines can also be controlled with the help of the PLINEGEN 
system variable, which acts as a toggle function. The default value of this variable is off. Entering 
the value ON turns on the Ltype gen option. Alternatively, select the appropriate option in 
the Linetype generation field in the Misc area of the Properties palette with the polyline 
selected.

Reverse Option
The Reverse option is used to change the start point of the polyline. On entering R and pressing 
ENTER at the Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/
Reverse/Undo] Command prompt, the start point of the polyline will be changed. This can be 
confirmed by using the Edit vertex option of the Edit Polyline tool before and after using the 
Reverse option. 

Undo (U) Option
The Undo option negates the effect of the most recent PEDIT operation. You can go back as 
far as you need to in the current PEDIT session by using the Undo option repeatedly until you 
get the desired screen. If you started editing by converting an object into a polyline, and you 
want to change the polyline back to the object from which it was created, the Undo option of 
the Edit Polyline tool will not work. In this case, you will have to exit to the Command prompt 
and use the UNDO command to undo the operation.

Editing Multiple Polylines 
Selecting the Multiple option of the Edit Polyline tool allows you to select more than one polyline 
for editing. You can select the polylines using any of the objects selection techniques. After the 
objects to be edited are selected, press ENTER or right-click to proceed with the command. 
The prompt sequence that will follow is given next.

Enter an option [Close/Open/Join/Width/Fit/Spline/Decurve/Ltype gen/Reverse/Undo]:

Join 
This option is used to join more than one polylines that may or may not be in contact with each 
other. Even the polylines that are not coincident can be joined using this option. The polylines 
are joined using a specified distance value called the Fuzz distance. After you select the Join 
option, the sequence of prompts is as follows.

Join Type = Extend
Enter fuzz distance or [Jointype] <current>: Enter a distance or J for changing the Jointype.

The prompt sequence to follow when you enter J at the above prompt is given next.

Enter join type [Extend/Add/Both] <Extend>:

Extend. This option is used to extend or trim the selected polylines at the endpoints that are 
nearest to each other, see Figure 18-27. Keep in mind that the segments of the selected polylines 
that are nearest to each other should not be parallel. This means that the segments that are 
nearest to each other should intersect at some point when extended. 

Add. This option is used to join the selected polylines by drawing a straight line between the 
nearest endpoints, see Figure 18-28. The fuzz distance should be greater than the actual distance 
between the two endpoints to be joined. 

Both. This option joins the endpoints by extending or trimming if possible; otherwise, it adds 
a line segment between the two endpoints.
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Figure 18-27  Joining two polylines using the 
Extend option

Figure 18-28  Joining two polylines using the Add 
option

Exercise 2							       Edit Polyline
a.	 Draw a line from point (0,0) to point (6,6). Convert the line into a polyline with a starting 

width 0.30 and a ending width 0.00. 

b.	 Draw different polylines of varying width segments and then use the Join option to join all 
the segments into one polyline. After joining the segments, make their width uniform, with 
the Width option.

Exercise 3							       Edit Polyline
a.	 Draw a staircase-shaped polyline and use the different options of the Edit Polyline tool to 

generate a fit curve, a quadratic B-spline, and a cubic B-spline, and then convert the curves 
back to the original polyline.

b.	 Draw square-wave-shaped polylines, and use different options of the Edit vertex option 
to navigate around the polyline, split the polyline into two at the third vertex, insert more 
vertices at different locations in the original polyline, and convert the square-wave-shaped 
polyline into a straight-line polyline.

Undoing Previous Commands 
  Quick Access Toolbar: Undo 	  Command:  UNDO  

The LINE and PLINE commands have the Undo option, which can be used to undo (nullify) 
the changes made within these commands. The UNDO command is used to undo a previous 
command or to undo more than one command at a time. This command can be invoked by 
entering UNDO at the Command prompt. Undo is also available in the Quick Access Toolbar, 
the Edit menu, and the Standard toolbar. The UNDO button in the Quick Access Toolbar can 
only undo the previous command and only one command at a time. If you right-click in the 
drawing area; a shortcut menu will be displayed. Choose Undo. It is equivalent to UNDO > 1 or 
to enter U at the Command prompt. The U command can undo only one operation at a time. 
You can use U as many times as you want until AutoCAD LT displays the message: Nothing to 
undo. When an operation cannot be undone, a message is displayed but no action takes place. 
External commands such as PLOT cannot be undone. 
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Undoing Previous Commands using the Quick Access 
Toolbar
Click the arrow on the Undo tool in the Quick Access Toolbar; the Undo list box will be displayed. 
All commands used recently will be listed in the Undo list box. Select the commands that you 
want to undo by placing the cursor in the list box and moving downward. The Commands 
selected are highlighted in blue color, as shown in Figure 18-29. The Status Bar below the Undo 
list box displays the number of commands selected. Click the left mouse button to confirm the 
selections. 

Figure 18-29  The Undo list box

Undoing Previous Commands using the Command prompt
To Undo previous commands using the Command  Line, enter UNDO at the Command prompt 
(if you are working in dynamic mode, the command will be entered at pointer input). The prompt 
sequence for the UNDO command is given next.

Command: UNDO 
Current settings: Auto = On, Control = All, Combine = Yes, Layer = Yes
Enter the number of operations to undo or [Auto/Control/BEgin/End/Mark/Back] <1>: 
Enter a positive number, an option, or press ENTER to undo a single operation.

Various options of this command are discussed next.

Number (N) Option
This is the default option. This number represents the number of previous command sequences 
to be deleted. For example, if the number entered is 1, the previous command is undone; if the 
number entered is 4, the previous four commands are undone, and so on. This is identical to 
invoking the U command four times, except that only one regeneration takes place. AutoCAD LT 
lets you know which commands were undone by displaying a message after you press Enter. 
The prompt sequence is given next.

Command: UNDO 
Enter the number of operations to undo or [Auto/Control/BEgin/End/Mark/Back]<1>:3 
PLINE LINE CIRCLE

Control (C) Option
This option lets you determine how many of the options are active in the UNDO command. 
You can disable the options you do not need. With this option, you can even disable the UNDO 
command. To access this option, type C. You will get the following prompt.

Enter an UNDO control option [ALL/None/One/Combine/Layer] <All>: Enter an option or 
press ENTER to accept the default.



18-30 AutoCAD LT 2013 for  Des igners

ALL 
The All option activates all the features (options) of the UNDO command.

None (N)
This option turns off the UNDO and the U commands. If you have used the BEgin and End 
options or Mark and Back options to create UNDO information, all of that information is 
undone. The prompt sequence for invoking the Control option is as follows.

Command: UNDO
Enter the number of operations to undo [Auto/Control/BEgin/End/Mark/Back] <1>: C
Enter an UNDO control option [ALL/None/One/Combine/Layer] <All>: N

If you try to use the U command now, while the UNDO command has been disabled, AutoCAD LT 
gives you the following message.

Command: U 
U command disabled. Use UNDO command to turn it on.

The prompt sequence for the UNDO command after issuing the None option is given next.

Command: UNDO
Enter an UNDO control option [All/None/One/Combine/Layer] <All>: Enter O or press 
ENTER to accept the default.

To enable the UNDO options again, you must enter the All or One (one mode) option. 

One (O)
This option restrains the UNDO command to a single operation. All UNDO information saved 
earlier during editing is scrapped. The prompt sequence is as follows.

Enter the number of operations to undo or [Auto/Control/BEgin/End/Mark/Back] <1>: C
Enter an UNDO control option [All/None/One/Combine/Layer] <All>: O 

If you then enter the UNDO command, you will get the prompt that is given next.

Command: UNDO 
Enter an option [Control] <1>: Press ENTER to undo the last operation or enter C to select 
another control option.

In response to this last prompt, you can now either press Enter to undo only the previous 
command, or go into the Control options by entering C. AutoCAD LT acknowledges undoing 
the previous command with messages such as given next.

Command: UNDO 
Enter an option [Control] <1>: 
CIRCLE
Everything has been undone

Tip
AutoCAD LT stores all information about all the UNDO operations performed in a drawing 
session. When you use the None control option of the UNDO command, this information is 
removed and valuable disk space is made available. In case of limited disk space, it may be a good 
idea to use the One suboption of the UNDO Control command. Using this option, you can use 
both the U and UNDO commands and at the same time to make the disk space available.
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Combine
This option allows you to combine all the consecutive Zoom and Pan operations as a single 
operation, while using the UNDO and REDO commands.

Layer
This option allows you to combine layer property actions as a single action.

Auto (A) Option
Enter A to invoke this option. The following prompt is displayed:

Enter UNDO Auto mode [ON/OFF] <On>: Select ON or OFF or press ENTER to accept the 
default setting.

This option is on by default and every menu item is a single operation. When you use the 
Begin and End options to group a series of commands as a single operation, entering U at the 
Command prompt removes the objects individually and not as a group, if the Auto option is on. 
But if Auto is off, entering U at the Command prompt will remove the entire group of objects 
you had grouped using the Begin and End options in one single operation. 

Also, if you have put a marker in between the start and end operations and if Auto is On, the 
group of commands till the marker, is undone altogether on using the Back option. This group 
of commands is considered to be a single group and is undone as a single command, although, 
entering U at the Command prompt removes the objects individually until the marker is 
encountered. But, if the Auto option is off, entering U at the Command prompt, or using the 
Back option of the UNDO command, undoes the entire group of operations irrespective of 
the marker being there.

BEgin (BE) and End (E) Options
A group of commands is treated as one command for the U and UNDO commands (provided 
Auto option is off) by embedding the commands between the BEgin and End options of the 
UNDO command. If you anticipate the removal of a group of successive commands later in a 
drawing, you can use this option, since all of the commands after the BEgin option and before 
the End option are treated as a single command by the U command (if the Auto option is Off). 
For example, the following sequence illustrates the possibility of removal of two commands.

Command: UNDO 
Enter the number of operations to undo or [Auto/Control/BEgin/End/Mark/Back] <1>: BE 
Command: CIRCLE  
Specify center point for Circle or [3P/2P/Ttr (tan tan radius)]: Specify the center.
Specify radius of circle or [Diameter] <current>: Specify the radius of the circle.
Command: PLINE 
Specify start point: Select the first point.
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: Select the next point.
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: Press ENTER.
Command: UNDO 
Enter the number of operations to UNDO or [Auto/Control/BEgin/End/Mark/Back]: E 
Command: U 

To start the next group once you have finished specifying the current group, use the End option 
to end this group. Another method is to enter the BEgin option to start the next group while 
the current group is active. This is equivalent to issuing the End option followed by the BEgin 
option. The group is complete only when the End option is invoked to match a BEgin option. 
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If U or the Undo command is issued after the BEgin option has been invoked and before the 
End option has been issued, only one command is undone at a time until it reaches the juncture 
where the BEgin option has been entered. If you want to undo the commands issued before the 
BEgin option was invoked, you must enter the End option so that the group is complete. This 
is demonstrated in the following example:

Example 2								         UNDO
Enter the following commands in the sequence given below, and notice the changes that take 
place on screen.

CIRCLE
POLYGON
UNDO BEgin (Make sure that the Auto is OFF)
PLINE
ELLIPSE
U
DONUT
UNDO End
TEXT
U
U
U
U

The first U command will undo the ELLIPSE command. If you repeat the U command, the 
PLINE command will be undone. Any further invoking of the U command will not undo any 
previously drawn object (POLYGON and CIRCLE, in this case), because after the PLINE 
is undone, you have an UNDO BEgin. Only after you enter UNDO End, you can undo the 
POLYGON and CIRCLE commands. In the example, the second U command will undo the 
TEXT command, the third U command will undo the DONUT and PLINE commands (these 
are enclosed in the group), the fourth U command will undo the POLYGON command, and 
the fifth U command will undo the CIRCLE command. Whenever the commands in a group 
are undone, the name of each command or operation is not displayed as it is undone. Only the 
name, GROUP, is displayed.

Tip
You can use the BEgin and End options only when the UNDO Control is set to All and the 
Auto option is off.

Mark (M) and Back Options
The Mark option installs a marker in the Undo file. The Back option lets you undo all the 
operations until the mark. In other words, the Back option returns the drawing to the point where 
the previous mark was inserted. For example, if you have completed a portion of your drawing and 
do not want anything up to this point to be deleted, you can insert a marker and then proceed. 
Then, even if you use the UNDO Back option, it will work only until the marker. You can insert 
multiple markers, and with the help of the Back option, you can return to the successive mark 
points. The following prompt sequence is used to introduce a mark point:

Command: UNDO
Enter the number of operations to undo or [Auto/Control/BEgin/End/Mark/Back]: M
 



18-33Grouping and Advanced  Edit ing  o f  Sket ched  Obje c t s
C

h
a

p
te

r
 1

8

The prompt sequence for using the Back option is given next.

Command: UNDO 
Enter the number of operations to undo or [Auto/Control/BEgin/End/Mark/Back]: B 

Once all the marks have been exhausted with the successive Back options, any further invoking 
of the Back option displays the message: This will undo everything. OK? <Y>. If you enter 
Y (Yes) at this prompt, all operations carried out since you entered the current drawing session 
will be undone. If you enter N (No) at this prompt, the Back option will be disregarded. 

You cannot undo certain commands and system variables, for example, DIST, LIST, DELAY, 
NEW, OPEN, QUIT, AREA, HELP, PLOT, QSAVE and SAVE, among many more. Actually, 
these commands have no effect that can be undone. Commands that change operating modes 
(GRID, UNITS, SNAP, ORTHO) can be undone, though the effect may not be apparent at 
first. This is the reason why AutoCAD LT displays the command names as they are undone.

Reversing the Undo Operation 
 Quick Access Toolbar:  Redo	 Toolbar: Standard > Redo 	 Command: REDO  

If you right-click in the drawing area, a shortcut menu is displayed. Choose Redo to 
invoke the REDO command. The REDO command brings back the process you removed 
previously using the U and UNDO commands. This command undoes the last UNDO 

command performed, provided it is entered immediately after the UNDO command. On using 
this command, the objects previously undone reappear on the screen. Click on the Redo button 
in the Quick Access Toolbar; the Redo drop-down (Figure 18-30) is displayed. It lists the 
commands that have been recently undone. Select the commands that you want to Redo and 
click the left mouse button to confirm the selection.

Figure 18-30  The Redo drop-down

Note
Consecutive Zoom and Pan operations can be undone or redone by using the Undo or Redo 
command only once so that the drawing returns to the initial zoom state. To disable this feature, 
clear the Combine zoom and pan commands check box in the Undo/Redo area of the User 
Preferences tab of the Options dialog box.

Renaming Named Objects 
  Menu Bar:  Format > Rename		  Command:  RENAME	

You can edit the names of the named objects such as blocks, dimension styles, layers, linetypes, 
styles, UCS, views, and viewports using the Rename dialog box. You can select the named object 
from the list in the Named Objects area of the dialog box. The corresponding names of all the 
objects of the specified type that can be renamed are displayed in the Items area. For example, 
if you want to rename the layer named HID to HIDDEN, the process will be as follows:

1.	 Enter RENAME at the Command prompt and then press ENTER; the Rename dialog box 
will be displayed, as shown in Figure 18-31.
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Figure 18-31  The Rename dialog box

2.	 Select Layers in the Named Objects list box. All the layer names in the current drawing 
that can be renamed are displayed in the Items list box.

3.	 Select HID in the Items list box to highlight it. HID will be displayed in the Old Name edit 
box.

4.	 Enter HIDDEN in the Rename To edit box, and choose the OK button.

Now, the layer named HID will be renamed to HIDDEN. You can view the change in the Layer 
drop-down list in the Layers panel of the Home tab or invoke the Layer Properties Manager 
dialog box to notice this change. You can rename blocks, dimension styles, linetypes, styles, 
UCS, views, and viewports in the same way. 

Note
The RENAME command cannot be used to rename drawing files created using the WBLOCK 
command. You can change the name of a drawing file by using the Rename option of your 
Operating System.

The Layer 0 and the Continuous linetype cannot be renamed and, therefore, do not appear in 
the Items list box of the Rename dialog box.

Removing Unused Named Objects
  Application Menu:  File > Drawing Utilities > Purge 	 Command:  PURGE  

This is another editing operation used for deletion and it was discussed earlier in relation to 
blocks. You can delete unused named objects such as blocks, layers, dimension styles, linetypes, 
text styles, shapes, and so on with the help of the PURGE command. When you create a new 
drawing or open an existing one, AutoCAD LT records the named objects in that drawing and 
notes other drawings that reference the named objects. Usually only a few of the named objects 
in the drawing (such as layers, linetypes, and blocks) are used. For example, when you create a 
new drawing, the prototype drawing settings may contain various text styles, blocks, and layers 
which you do not want to use. Also, you may want to delete particular unused named objects 
such as unused blocks in an existing drawing. Deleting inactive named objects is important and 
useful because doing so reduces the space occupied by the drawing. With the PURGE command, 
you can select the named objects you want to delete. You can use this command at any time in 
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the drawing session. When you invoke the PURGE command, the Purge dialog box is displayed 
(Figure 18-32).

Figure 18-32  The Purge dialog box with items that can be purged

View items you can purge
When this radio button is selected, AutoCAD LT displays the tree view of all  the named objects 
that are in the current drawing and those can be purged. When this radio button is selected, the 
Items not used in drawing area, and the two check boxes, Confirm each item to be purged and 
Purge nested items, are displayed in the dialog box.  These are discussed next.

Items not used in drawing
This area lists all the named objects that can be purged. You can list the items of any object 
type by choosing the plus (+) sign or by double-clicking on the named object in the tree view. 
Select them to be purged. You can select more than one item by holding down the SHIFT or 
the CTRL key and selecting the items.

Confirm each item to be purged
This check box is selected to confirm before purging the selected item. The Confirm Purge 
dialog box is displayed when items are selected to be purged and after the Purge or Purge All 
button is chosen. You can confirm or skip the items to be purged in this dialog box.

Purge nested items
This check box, when selected, removes all the nested items not in use. This removes the nested 
items only when you choose the Purge All button or select blocks.
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Purge zero - length geometry and empty text objects
While drawing a line, arc, or polyline if the same point is selected as the start and the end 
points by mistake, then a zero length geometry will be created. Also, if there is only empty space 
created by mistake while creating a text, then the Purge zero-length geometry and empty text 
objects check box will be available. You can purge the zero length geometry or the empty spaces 
by selecting this check box.

View items you cannot purge
This radio button is used to display the tree view of the items that you cannot purge. These are 
the items that are used in the current drawing or are the default items that cannot be removed 
(Figure 18-33). Choosing this radio button displays the tree view in the Items currently used in 
drawing area of the dialog box. When you select an object in this tree view, information about 
why you cannot purge this object is displayed below the tree view.

Figure 18-33  The Purge dialog box with items that cannot be removed

Note
The Entire Drawing option of the Write Block dialog box, which is invoked on using the 
WBLOCK command or the -WBLOCK option, has the same effect as the PURGE All command. 
The only difference is that in this case the unused named objects are removed automatically without 
any verification, though this method is much faster as compared to the previous one.

Standard objects created by AutoCAD LT (such as layer 0, STANDARD text style, Dimension 
style, and linetype CONTINUOUS) cannot be removed by the PURGE command, even if these 
objects are not used.
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Setting Selection Modes Using the Options 
Dialog Box 

  Application Menu:   Options	 	 Command:   OPTIONS  

When you select a number of objects, the selected objects form a selection set. Selection of the 
objects is controlled in the Options dialog box (Figure 18-34)  that is invoked by choosing the 
Options button from the Application Menu. Six selection modes are provided in the Selection tab 
of this dialog box. You can select any one of these modes or a combination of various modes.

Figure 18-34  The Selection tab of the Options dialog box

Noun/verb selection 
By selecting the Noun/verb selection check box, you can select the objects (noun) first and then 
specify the operation (verb) (command) to be performed on the selection set. This mode is active 
by default. For example, if you want to move some objects when the mode Noun/verb selection is 
enabled, first select the objects to be moved, and then invoke the MOVE command. The objects 
selected are highlighted automatically when the MOVE command is invoked, and AutoCAD LT 
does not issue any Select objects prompt. The following are some of the commands that can be 
used on the selected objects when the Noun/verb selection mode is active.

ARRAY	 BLOCK		  CHANGE	 CHPROP	 COPY		
DVIEW	 EXPLODE		  ERASE		 LIST		  MIRROR	
MOVE	 Properties		  ROTATE	 SCALE		 WBLOCK	

The following are some of the commands that are not affected by the Noun/verb selection 
mode. You are required to specify the objects (noun) on which an operation (command/verb) is 
to be performed, after specifying the command (verb).
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BREAK		  CHAMFER	 DIVIDE	 EDGESURF	 EXTEND
FILLET		  MEASURE	 OFFSET	 REVSURF	 RULESURF	  
TABSURF		  TRIM

When the Noun/verb selection mode is active, the PICKFIRST system variable is set to 1 (On). 
In other words, you can also activate the Noun/verb selection mode by setting the PICKFIRST  
system variable to 1 (On).

Use Shift to add to selection Option
The next option in the Selection modes area of the Selection tab of the Options dialog box 
is Use Shift to add to selection. Selecting this option establishes the additive selection mode, 
which is the normal method of most Windows programs. In this mode, you have to hold down 
the Shift key when you want to add objects to the selection set. For example, suppose X, Y, and 
Z are three objects on the screen and you have selected the Use Shift to add to selection check 
box in the Selection modes area of the Options dialog box. Select object X. It is highlighted 
and put in the selection set. After selecting X, and while selecting object Y, if you do not hold 
down the Shift key, only object Y is highlighted and it replaces object X in the selection set. 
On the other hand, if you hold down the Shift key while selecting Y, it is added to the selection 
set (which contains X), and the resulting selection set contains both X and Y. Also, both X and Y 
are highlighted. To summarize the concept, objects are added to the selection set only when the 
Shift key is held down while objects are selected. Objects can be discarded from the selection 
set by reselecting these objects while the Shift key is held down. If you want to clear an entire 
selection set quickly, draw a blank selection window anywhere in a blank drawing area. You can 
also right-click to display a shortcut menu and choose Deselect All. All selected objects in the 
selection set are discarded from it. 

When the Use Shift to add to selection mode is active, the PICKADD system variable is set to 
0 (Off). In other words, you can activate the Use Shift to add to selection mode by setting the 
PICKADD system variable to off.

Implied windowing
By selecting this option, you can automatically create a Window or Crossing selection when the 
Select objects prompt is issued. The selection window or crossing window, in this case, is created 
in the following manner: At the Select objects prompt, select a point in the empty space on the 
screen. This becomes the first corner point of the selection window. After this, AutoCAD LT 
asks you to specify the other corner point of the selection window. If the first corner point is to 
the right of the second corner point, a Crossing selection is defined; if the first corner point is 
to the left of the second corner point, a Window selection is defined. The Implied windowing 
check box is selected by default.

If this option is not active, or if you need to select the first corner in a crowded area where 
selecting would select an object, you need to specify Window or Crossing at the Select objects 
prompt, depending on your requirement.

When the Implied windowing mode is active, the PICKAUTO system variable is set to 1 (On). 
In other words, you can activate the Implied windowing mode by setting the value of the  
PICKAUTO system variable to 1 (On).

Press and drag
This selection mode is used to govern the way you can define a selection window or a crossing 
window. When you select this option, you can create the window by pressing the pick button to 
select one corner of the window and continuing to hold down the pick button and dragging the 
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cursor to define the other diagonal point of the window. When you have the window you want, 
release the pick button. If the Press and drag mode is not active, you have to select twice to 
specify the two diagonal corners of the window to be defined. This mode is not active by default. 
This implies that to define a selection window or a crossing window, you have to select twice to 
define their two opposite corner points.

When the Press and drag mode is active, the PICKDRAG system variable is set to 1 (On). In 
other words, you can activate the Press and drag mode by setting PICKDRAG to On.

Object grouping
This turns the automatic group selection on and off. When this option is on and you select a 
member of a group, the whole group is selected. You can also activate this option by setting the 
value of the PICKSTYLE system variable to 1. (Groups were discussed earlier in this chapter.) 

Tip
You can clear the Object grouping check box in the Selection Modes area of the Selection 
tab of the Options dialog box to be able to select the objects of a group individually for editing 
without having to explode the group.

Associative Hatch
If the Associative Hatch check box is selected in the Selection modes area of the Selection tab of 
the Options dialog box, the boundary object is also selected when an associative hatch is selected. 
You can also select this option by setting the value of the PICKSTYLE system variable to 2 or 3. 
It is recommended that you select the Associative Hatch check box for most drawings.

Pickbox Size
The Pickbox slider bar controls the size of the pickbox. The size ranges from 0 to 20. The 
default size is 3. You can also use the PICKBOX system variable.

Window selection method
This drop-down list can be used to control the selection method. During the window selection, 
you can control the window behaviour in the following two ways:

Click and Click. Using this method, you can define the selection window by clicking in the 
screen to specify the start point and endpoint of the window.

Press and drag. Using this method, you can define the selection window by clicking on any 
position in the drawing screen and dragging the cursor according to requirement.

You can also use both options by selecting Both - Automatic detection from the Window 
selection method drop-down.

  Self-Evaluation Test	
Answer the following questions and then compare them to those given at the end of this 
chapter:

1.	 Even if a group is defined as selectable and the PICKSTYLE system variable is set to 0, you 
cannot select the entire group by selecting one of its members. (T/F)

2.	 The Properties palette is used to change the properties associated with an object.  (T/F) 
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3.	 The Properties palette can be used to modify the geometry of objects apart from their 
general properties. (T/F)

4.	 The RENAME command can be used to change the name of a drawing file created by using 
the WBLOCK command. (T/F) 

5.	 A group of commands is treated as one command for the U and UNDO commands 
by embedding them between the __________ and __________ options of the UNDO 
command.

6.	 If the Press and Drag mode is not active, you have to select __________ to specify the two 
diagonal points of a selection window.

7.	 The _________ option in the prompt of the Edit Polyline tool can be used to change the 
starting and ending widths of a polyline separately to a desired value. 

8.	 The __________ option of the Edit Polyline tool is used to select more than one polyline. 

9.	 You can move past the first and last vertices in a closed polyline by using either the ______ 
option or the __________ option.

10.	 While using the _______ tool, if you select a line or an arc, AutoCAD LT provides you with 
the option of converting them into a polyline first.

  Review Questions	
Answer the following questions:

1.	 When you use the GROUP command to form object groups, AutoCAD LT lets you 
sequentially highlight the groups of which the selected object is a member. (T/F) 

2.	 The standard objects created by AutoCAD LT (such as layer 0, STANDARD text style, and 
linetype CONTINUOUS) cannot be removed by using the PURGE command. (T/F) 

3.	 If you explode an object, it remains identical to its original geometry; only the color and 
linetype may change because of floating layers, colors, or linetypes. (T/F) 

4.	 The PURGE command has the same effect as that of the WBLOCK Entire drawing or the 
-WBLOCK method. The only difference is that with the PURGE command, deletion takes 
place automatically. (T/F) 

5.	 If you have made a copy of a group without naming the copy, its name is displayed in which 
of the following notations in the Group Name list box?

		  (a) $A1				    (b) @A1
		  (c) %A1				   (d) *A1	

6.	 Which of the following options is used delete a selected group from a drawing?

		  (a) Remove			   (b) Reorder
		  (c) Explode	   		  (d) Rename
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7.	 Which of the following system variables controls the smoothness of a curve?
		
		  (a) SPLINETYPE		  (b) SPLINESEGS
		  (c) PLINEGEN			  (d) PICKFIRST

8.	 Which of the following options of the Edit Polyline tool can straighten a curve drawn with 
the help of the Polyline tool?

		  (a) Join				   (b) Close
		  (c) Decurve			   (d) None of these

9.	 Which of the following properties cannot be changed using the CHANGE command?

		  (a) Lineweight			   (b) Color
		  (c) Plotstyle			   (d) Thickness				  

10.	 The ________ command can be used to change the name of a block. 

11.	 If the  __________ option of the UNDO command is set to off, any group of commands 
grouped together using the Begin and End options of the UNDO command are undone 
together. 

12.	 Circles drawn using the CIRCLE command can be changed to _________.

13.	 The __________ option in the GROUP command is used to change the order of the objects 
in the selected group.

14.	 You can select a group by entering _________ at the Select objects: prompt.
 
15.	 The __________ option of the UNDO command disables the UNDO and U commands 

entirely.

Exercise 4			         Properties and Edit Polyline
Draw part (a) in Figure 18-35 and then using the Properties and relevant Edit Polyline 
tool options, convert it into parts (b), (c), and (d). The linetype used in part (d) is HIDDEN.
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Figure 18-35  Drawing for Exercise 4

Exercise 5						      	 Edit Polyline
Draw the sketch shown in Figure 18-36 using the Line tool. Change the object to a polyline 
with a width of 0.05.

Figure 18-36  Drawing for Exercise 5

Exercise 6						      	 Edit Polyline
Draw part (a) of Figure 18-37 and then using the relevant Edit Polyline tool options, convert 
it into drawing (b).



18-43Grouping and Advanced  Edit ing  o f  Sket ched  Obje c t s
C

h
a

p
te

r
 1

8

Figure 18-37  Drawing for Exercise 6

Exercise 7						      	 Edit Polyline
Draw part (a) of Figure 18-38 and then using the relevant Edit Polyline tool options, convert it 
into drawings (b), (c), and (d). Identify the types of curves.

Figure 18-38  Drawing for Exercise 7
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Exercise 8						      	 Edit Polyline
Draw part (a) of Figure 18-39 and then using the relevant Edit Polyline tool options, convert 
it into drawing (b).

Figure 18-39  Drawing for Exercise 8

Exercise 9						      	 Edit Polyline
Draw part (a) of Figure 18-40 and then using the relevant Edit Polyline tool options, convert 
it into part (b) of the drawing.

Figure 18-40  Drawing for Exercise 9
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Exercise 10						      Edit Polyline
Draw the part (a) of Figure 18-41 and change it into the figure shown in part (b) by using the 
appropriate commands. You can also use grips to obtain this illustration. Assume the missing 
dimensions.

Figure 18-41  Drawing for Exercise 10

Exercise 11						      Edit Polyline
Create the drawing shown in Figure 18-42. Use the splined polylines to draw the break lines. 
Dimension the drawing as shown in the figure.
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Figure 18-42  Drawing for Exercise 11

 Answers to Self-Evaluation Test	
1. T, 2. F, 3. T, 4. F, 5. Begin, End, 6. Twice, 7. Width, 8. Multiple, 9. Next, Previous, 
10. Edit Polyline


